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PPrreeffaaccee  

This document provides step-by-step instructions to install the Oracle Financial Services 

Financial Accounting and Reporting Standards (IFRS and CECL) Pack 8.0.5.1.0 Interim Release. 

This chapter discusses the following topics: 

 Audience 

 How this Guide is organized 

 Recommended Environment 

 Related Documents 

 Conventions Used 

Audience  

The Oracle Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 

pack Installation and Configuration Guide is intended for administrators and implementation 

consultants who are responsible for installing and maintaining the application pack components.  

The document assumes you have experience in installing Enterprise components. Basic 

knowledge about the OFSAA FARS pack components, OFSAA Architecture, UNIX commands, 

Database concepts, and Web Server / Web Application Server is recommended. 

PPrreerreeqquuiissiitteess  ffoorr  tthhee  AAuuddiieennccee  

The document assumes that you have experience in installing Enterprise components and basic 

knowledge about the following is recommended.  

The following are the expected preparations from the administrator before starting the actual 

installation: 

 Oracle Financial Services Advanced Analytical Applications Infrastructure pack components 

 OFSAA Architecture 

 UNIX Commands 

 Database Concepts 

  Web Server/ Web Application Server  

How this Guide is Organized 

The Oracle Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 

pack Installation and Configuration Guide includes the following topic: 

 Oracle Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 
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RReeccoommmmeennddeedd  EEnnvviirroonnmmeenntt  

The infrastructure application has been tested with Microsoft Internet Explorer™ browser. For 

best viewing of Infrastructure pages, set the screen resolution to a minimum resolution of 1024 x 

768 pixels. 

RReellaatteedd  DDooccuummeennttss  

This section identifies additional documents related to OFS FARS Infrastructure. You can access 

Oracle documentation online from Documentation Library OHC Documentation Library. 

 Oracle Financial Services Loan Loss Forecasting and Provisioning User Guide 

 Oracle Financial Services Hedge Management User Guide 

CCoonnvveennttiioonnss  aanndd  AAccrroonnyymmss  

Conventions Description 

Actions are indicated in Bold. 

Command or query is indicated in Courier New font. 

AIX Advanced Interactive eXecutive 

Atomic Schema Database schema where the application data model is uploaded. 

Config Schema Database schema which contains setup related configurations and metadata. 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

FARS Financial Accounting and Reporting Standards (IFRS and CECL) 

FTP File Transfer Protocol 

GUI Graphical User Interface 

HTTPS Hypertext Transfer Protocol Secure 

IR Interim Release 

J2C J2EE Connector 

J2EE Java 2 Enterprise Edition 

http://docs.oracle.com/cd/E60529_01/homepage.htm
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Conventions Description 

JDBC Java Database Connectivity 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

JVM Java Virtual Machine 

ML Maintenance Level  

OFSAAI Oracle Financial Services Analytical Applications Infrastructure 

OFS AAAI Oracle Financial Services Advanced Analytical Applications Infrastructure 

Application Pack 

OHC Oracle Help Center 

RHEL Red Hat Enterprise Linux 
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11  OOFFSS  FFiinnaanncciiaall  AAccccoouunnttiinngg  aanndd  RReeppoorrttiinngg  SSttaannddaarrddss  ((IIFFRRSS  aanndd  

CCEECCLL))PPaacckk  RReelleeaassee  88..00..55..11..00  

This Maintenance Level release (ML) of OFS Analytical Applications (OFSAA) Financial 

Accounting and Reporting Standards (IFRS and CECL) is cumulative and includes all 

enhancements and bug fixes done since the OFS Analytical Applications (OFSAA) Financial 

Accounting and Reporting Standards (IFRS and CECL) Application Pack v8.0 GA release. For 

more information, refer to the Oracle Financial Services IFRS Release 8.0.5.0.0 Installation 

Guide. 

11..11  PPrree  IInnssttaallllaattiioonn  RReeqquuiirreemmeennttss  

 The minimum patch set level should be 8.0.5.0.0. 

11..22  HHooww  ttoo  aappppllyy  tthhiiss  ppaattcchh??  

11..22..11  IInnssttaalllliinngg  OOFFSS  IIFFRRSS  

Refer to the following instructions to download, extract, install, and configure this patch: 

1. Login to https://support.oracle.com/ and search for 26959155 under the Patches & 

Updates tab. 

2. Download the OFSAA 8.0.5.0.0 IFRS ML RELEASE #1 archive file and copy it to your 

OFSAA server in Binary mode. 

NOTE:  There are different archive files for different operating systems such as AIX, 

Solaris, and RHEL/OEL. 

3. Stop all the OFSAAI services. For more information, see the Start/Stop Infrastructure 

Services section in Oracle Financial Services Financial Accounting and Reporting 

Standards (IFRS and CECL) Pack Installation Guide Release 8.0.5.0.0. 

4. Login to the OFSAA server as a non-root user and navigate to the $FIC_HOME folder. 

5. Assign WRITE permission to the files/ folders such as common scripts, 

EXEWebService, ficapp, ficweb, and ficdb in the $FIC_HOME folder by executing the 

command: 

chmod -R 775 * 

6. If you have to Unzip utility, skip to the next step or download the Unzip utility (OS-

specific) and copy it in Binary mode to the directory that is included in your PATH 

variable, typically $HOME path or directory in which you have copied the 8.0.5.1.0 ML. 

 Uncompress the unzip installer file using the command: 

uncompress unzip_<os>.Z 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
https://support.oracle.com/
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
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NOTE:  If you notice an error message “uncompress: not found [No such file or 

directory]” when the package is not installed, contact your UNIX 

administrator. 

7. Give EXECUTE permission to the utility using the command: 

chmod 751 unzip_<os> 

8. Extract the contents of the 8.0.5.1.0 ML archive file using either of the following 

commands: 

unzip_<os> -a <name of the file to be unzipped> 

OR 

unzip –a <name of the file to be unzipped> 

NOTE:  The above “-a” option is mandatory to unzip the archive file. 

9. Update the params.conf file present in the OFS_IFRS_PACK/OFS_IFRS/conf folder. 

The update instructions are present in this file itself. 

If you do not have permission to create a new folder for backup, then provide an 

alternate location as value for BACKUP_LOCATION tag in params.conf file, present in 

the OFS_IFRS_PACK folder. 

In case of customized datamodel upload, then update the params.conf file present in 

the OFS_IFRS_PACK/OFS_IFRS/conf/ folder accordingly. 

10. Give EXECUTE permission to the ML patch installer script. Navigate to the folder 

OFS_AAI and execute the command: 

chmod 755 OFSAAIUpdate.sh 

11. Execute the following command:  

./OFSAAIUpdate.sh 

12. Verify if the ML is applied successfully by checking the log files generated in 

OFS_IFRS_PACK/OFS_IFRS/logs and OFS_IFRS_PACK/logs folders. You can ignore 

ORA-00001 and ORA-02292 in the log file. In case of any other errors, contact Oracle 

Support. 

13. Post successful installation of the ML, perform the following steps: 

 Clear the application cache. Navigate to the following path depending on the 

configured web application server and delete the files. 

o Tomcat: <Tomcat installation folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

https://support.oracle.com/
https://support.oracle.com/
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o Weblogic: <Weblogic installation location>/domains/<Domain 

name>/servers/<Server name>/tmp/_WL_user/<Application name> 

o Websphere: <Websphere installation directory>/AppServer/profiles/<Profile 

name>/temp/<Node name>/server1/<Application name>/<.war file name> 

14. Delete the existing EAR/WAR file available in the folder $FIC_HOME/ficweb. 

15. Generate the application EAR/WAR file and redeploy the application onto your 

configured web application server. For more information on generating and deploying 

the EAR/ WAR file, refer to the Post Installation Configuration section in Oracle 

Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 

Pack Installation Guide Release 8.0.5.0.0. 

16. Restart all the OFSAAI services. For more information, refer to the Start/Stop 

Infrastructure Services section in Oracle Financial Services Financial Accounting and 

Reporting Standards (IFRS and CECL) Pack Installation Guide Release 8.0.5.0.0. 

11..33  PPoosstt  IInnssttaallllaattiioonn  CCoonnffiigguurraattiioonnss  

 Download and install the mandatory patches 30061459 and 30273984, from My Oracle 

Support. See the Readme available with the patch for instructions on installing the patch.  

 Download and install the mandatory patch 30055095, from My Oracle Support. See the 

Readme available with the patch for instructions on installing the patch.  

 Download and install the compatibility patch 28268606 from My Oracle Support. See the 

Readme available with the patch for instructions on installing the patch. 

 Download and install the mandatory one-off patch 27412534 from My Oracle Support. See 

the Readme available with the patch for instructions on installing the patch. 

 Download and install the mandatory one-off patch 27504805 from My Oracle Support. See 

the Readme available with the patch for instructions on installing the patch. 

 Download and install the mandatory one-off patch 27460232 from My Oracle Support. See 

the Readme available with the patch for instructions on installing the patch. 

 Download and install the one-off patch 27080714 from My Oracle Support, if you want to 

customize the Data Model. See the Readme available with the patch for instructions on 

installing the patch. 

 The default tasks present in the LLFP application are included in ECL and Stage runs to 

gather 100% table statistics. Based on the data volume, you need to optimize these tasks to 

gather statistics on the appropriate sample size. To do this, you need to modify the function 

fn_gather_stats in the atomic schema by passing the parameter estimate_percent to the 

GATHER_TABLE_STATS function call. 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
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 Execute the script hm_update_rcy_to_fvruns.sql, available at 

OFS_IFRS_PACK/OFS_IFRS/bin/scripts/atomic/insert/ to update the default reporting 

currency for all existing Fair Value Run definitions. You need to provide the currency code as 

input to the prompt which must be an active currency. This updates the reporting currency-

related data to FSI_HM_RUN_DETAILS, FSI_ALM_DETERMINISTIC_PROCESS 

(OUTPUT_FCAST_RATES_FLG as 1), and FSI_ALM_DTL_FORECAST_EX_AUDIT tables. 

11..33..11  CCrreeaattiinngg  GGlloobbaall  VVaarriiaabblleess  ffoorr  OOBBIIEEEE  

To create the global variables for OBIEE, in this release of IFRS application, perform the following 

procedure: 

1. Host the RPD and Catalog for LLFP/HM solution as part of this release. 

2. Login into OBIEE/analytics using the application URL. 

3. Click the Analysis link. 

 

4. Click and select the subject area as IFRS 9. 

 

5. The subject area details are displayed. 

Expand a folder and double click on any column from the subject area. 

Click the Edit formula menu item. 
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6. Click the Variables tab and select the Global option from the menu. 

 

7. Create a global variable with the following details: 

 Variable Name: denomination 

Value: case when '@{denomination}{in thousand}' = 'in thousand' then 1000 

else 1000000 end 

This variable is used to divide all amount values by thousand or million, 

depending on the selected criteria. 

 Variable Name: RSkey 

Value: case when "Run"."Run Execution Id" = '@{RunId}{1476270723292}' 

then "Run"."Run Skey" end 

 Variable Name: stage 

Value: "Previous IFRS9 Stages"."IFRS Stage Code" 

8. Refresh the materialized view by executing the following queries: 
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 EXECUTE 

DBMS_MVIEW.REFRESH(LIST=>'FCT_IFRS_STG_DETERMINATION_MV'); 

This refreshing of MV should be done when there is a change to the Stage 

Determination table. 

 EXECUTE 

DBMS_MVIEW.REFRESH(LIST=>'FCT_COLLECTIVE_ASSESSMENT_MV’); 

11..33..22  CCoonnffiigguurraattiioonnss  ttoo  DDeeppllooyy  tthhee  LLLLFFPP//HHMM  BBII  AApppplliiccaattiioonn  

The following are the steps to configure the LLFP/HM BI Analytics: 

Before you begin this process, ensure that Oracle Business Intelligence (Version 11.1.1.9.0 or 

12.2.1.2.0) installation is completed and is available. 

1. Set the <Oracle BI Instance Home> directory. 

For example: /u01/OBIEE11G/instances/instance1 

2. Start WebLogic AdminServer. 

a. Set the <BI Domain Home> directory. 

i. For Example: 

/u01/OBIEE11G/user_projects/domains/bifoundation_domain 

b. Navigate to <BI Domain Home >/bin and execute the following command: 

nohup ./startWebLogic.sh & 

NOTE:  Bringing up this service may take a few minutes depending on your 

environment. Check the logs using the command: 

tail –f nohup.out 

3. Start Node Manager.  

a. Set the < WebLogic Server Home > directory>.  

For example: /u01/OBIEE11G/wlserver_<version> 

b. Navigate to <WebLogic Server Home>/server/bin and execute the following 

command: 

nohup ./startNodeManager.sh & 

4. Start WebLogic Managed Server (bi_server1).  

a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup).  

b. Under the Environment tab, click the Servers link. 
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The bi_server1 displays the shutdown state at this point. 

 

c. Click the Control tab.  

d. Select the bi_server1 line by clicking on the left tick box.  

e. Click the Start button at the top of the list and confirm starting this service. 

 

f. The state will update to the “RUNNING” mode after a few minutes. 

5. Start OBIEE services and log in. 

a. Starting services From EM screen: 
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i. Log in to the EM administration screen using the URL: http://localhost:7001/em 

(Replace the hostname and port number based on your setup). Use the login 

you created in the OBIEE installation to log in.  

ii. Expand the 'Business Intelligence' node on the left and choose the Core 

application.  

 

iii. Click the Overview Tab. 

 

iv. Click Restart (or Start) under the Manage System section.  

v. Click Yes on the dialog box to confirm the action. Wait for a message that 

confirms the successful restart. 

b. If the start process using EM is not successful and returning an error about 

OPMNCTL not up, follow the starting process with OPMNCTL.  

i. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.  

ii. Execute the command ./opmnctl status. This displays the status of all the 

OBIEE core services  

iii. Execute the command ./opmnctl startall or ./opmnctl stopall depending on 

your requirement. 

6. Deploy RPD and web catalog file(s).  

If your OBIEE version in 11g, perform this procedure: 
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a. Navigate to folder $FIC_HOME/LLFP_DASHBOARDS/ which contains LLFP.rpd 

file and $FIC_HOME/LLFP_DASHBOARDS/ which contains LLFP.catalog file.  

i. Login to OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em).  

ii. Click on coreapplication from the Business Intelligence tab on the left-hand 

side.  

iii. Under coreapplication, select the Deployment tab and click the Lock and Edit 

Configuration button located below the title coreapplication. The following 

screen is displayed: 

 

iv. RPD Deployment: Select the Browse button available under the Upload BI 

Server Repository section and select LLFP.rpd file from the local folder. Enter 

the Repository password ‘Administrator1’.  

If your OBIEE version in 12c, perform this procedure: 

 Copy the RPD file to the /tools/bin folder present in the Weblogic 

domain path. 

 Execute the datamodel.sh, file present in /tools/bin folder to deploy 

RPD. 

./datamodel.sh uploadrpd -I < LLFP.rpd > -SI ssi -U weblogicuser 

-P weblogicpassword 

 Restart the Weblogic server. 

v. Web catalog Deployment:  

 Create a new web catalog folder for the LLFPBI application through the 

Enterprise Manager of OBIEE. 
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 Set the Catalog Location available under ‘BI Presentation Catalog’ as 

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComp

onent/$COM PONENT_NAME/catalog/LLFPBI.  

 Click Apply and then click Activate changes. The following pop up is 

displayed after successful activation.  

 

 Click the Close button and switch to the Capacity management tab.  

 Restart the presentation services. Under the System Components 

Availability, select Presentation Services and click on Restart Selected 

option.  

 

vi. Once the Presentation Service is restarted, it displays the pop up notifying the 

successful restart. Click Close.  

vii. Verify that the new folder structure is created in the system. It can be found 

under path: <Oracle BI Instance Home> 

\bifoundation\OracleBIPresentationServicesComponent\coreapplication_obips1

\catalog\LLFPBI 

viii. This LLFPBI folder will be having a root folder which in turn contains three 

folders named shared, system, and users. 
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b. Open the Catalog Manager  

i. Navigate to File menu and open the catalog online (File->Open catalog) by 

giving the necessary credentials based on your setup (Type - (online), URL - 

(http://<ipaddress>:<port>/analytics/saw.dll).  

ii. Once the catalog is opened, it displays a folder structure on the left-hand side. 

Select the shared folder in the LHS tree structure.  

iii. Go to the ‘File’ menu and select ‘Unarchive’. It asks for the path for a file.  

iv. Browse the path of the archived catalog file saved in your local folder using the 

Browse button in the pop-up. Click OK.  

v. The catalog is unarchived in a specified location. A pop up for successful 

operation is displayed. Restart the presentation services once again.  

c. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) and login with 

credentials based on your setup. Verify the availability of the catalog. 

If your OBIEE version in 12c, perform this procedure: 

a. Deploy the Catalog file in OBIEE Catalog Manager. 

b. Navigate to the 12c Analytics URL, http://serverip:serverport/analytics/saw.dll. 

c. Login to the URL with Weblogic credentials. 

d. Unarchive the catalog file. 

7. Configure tnsnames.ora.  

a. Open tnsnames.ora file under the folder - <Oracle Home>/network/admin.  

b. Make sure that an entry is made in the tnsnames.ora to connect to the atomic 

schema of the OFSAA application.  

c. Save the tnsnames.ora file.  

8. Configure the ODBC data source to connect to Oracle BI Server.  

a. Navigate to Control Panel>Administrative Tools>Data Sources (ODBC).  

b. Select the System DSN tab and click the Add button.  



  OFS FARS 8.0.5.1.0 Installation Guide 

Oracle Financial Services Software 

18 

c. Select a driver-specific to (Oracle BI Server 11g) and click the Finish button.  

d. Enter Name and Server details (specify the Host Name or IP Address of the BI 

Server) and click Next.  

e. Enter Oracle BI Server login id and password (Enter User Name and Password 

created at the time of OBIEE installation). Click Next.  

f. Click Finish.  

9. Modify the connection pool and set the properties.  

a. Open the OBI Administration tool.  

b. Select Start > Programs > Oracle Business Intelligence > BI Administration.  

c. Enter the Repository password as ‘Administrator1’. (You do not need to provide 

this password if you are using OBIEE version 12c). 

d. In the Physical layer, double-click the Connect Pool. The properties of 

Connection Pool LLFP is displayed. 

e. In the General tab, edit / check the following entries:  

i. Call Interface: (OCI 11g/12c).  

ii. Data source name: <tnsnames.ora entry created in the step 8.b connecting to 

OFSAA atomic schema>.  

iii. User name: <enter atomic db user name>.  

iv. Password: <enter atomic db user password>.  

v. Confirm password and Click OK to close the window.  

vi. Similarly, configure the connection pools for ‘LLFPBI’. 

NOTE:  Repeat similar steps from (g) above for connection pool 'Connection 

Pool MR' under Database 'Market Risk'.  

vii. Click Save to save the RPD file.  

viii. Click No for the Global Consistency Message.  

ix. Close the RPD file (File / Exit).  

10. Login into LLFP/HM BI Application using the URL: http://localhost:<port 

number>/analytics (Replace the port number based on your setup). 

11..33..33  UUppddaattiinngg  OOBBIIEEEE  UURRLL  

To access the respective Business Intelligence Analytics Application, you need to update the 

OBIEE URL in the table 'AAI_MENU_B', once the OBIEE environment is up and running. 
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The following statement needs to be executed in the config schema: 

UPDATE AAI_MENU_B 

SET V_MENU_URL = '<obieeURL>' 

WHERE V_MENU_ID IN ('<List of enabled BI Analytical Links for a 

particular Media Pack >') 

/ 

COMMIT; 

/ 

For OFS LLFP: 

UPDATE AAI_MENU_B SET V_MENU_URL = 'http://ifrsip:port/analytics' WHERE 

V_MENU_ID IN ('OFS_LLFP_ANALYTICS’) 

/ 

COMMIT; 

/ 

For OFS HM: 

UPDATE AAI_MENU_B SET V_MENU_URL 

='http://ofss2221196.in.oracle.com:7001/analytics' WHERE V_MENU_ID = 

'OFS_HM_ANALYTICS'; 

/ 

COMMIT; 

/ 
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